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Confidentiality Statement 

All information provided in this document by Forex Ai is provided on a commercial-in-confidence 

basis, as its release into the general commercial environment may be advantageous to Forex-Ai 

competitors and harmful to our business. 

This document and any electronic version thereof, may only be copied and/or provided to you. It may 

not be provided to any other person, organization and competitor without the prior written permission 

of Forex Ai. 

Legal Disclaimer 

Forex, futures, and options trading have large potential rewards, but also carry large potential risks. You must be 

aware of the risks and be willing to accept them in order to invest in the Forex, futures and options markets. Do 

not trade with money you cannot afford to lose. This Forex Ai system is neither a solicitation nor an offer to 

Buy/Sell currencies, futures or options. No representation is being made that any account will or is likely to 

achieve profits or losses similar to those discussed in this document. The past performance of any trading 

system or methodology is not indicative of future results. 

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS WHICH ARE PRESENTED 

HERE IN PART HAVE CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, 

SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT 

BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF 

ANY, OF CERTAIN MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING 

PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE 

BENEFIT OF HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS 

LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN. 
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1 Introduction 

 

Congratulation on your purchase of one of the worlds most advanced automated trading 

systems utilizing Artificial Intelligence. 

 

Do not install the Expert and definitely do not use it for live trading before you 

have read this user manual in full. Incorrectly configured Forex-AI expert will 

not produce profitable trading in the long run, so it is essential that you have 

followed the instructions in this manual to install, configure and train the expert 

correctly. 

 

Forex AI Automatic Trading system for MetaTrader 4 is an advanced piece of application 

which uses Neural network to make decisions as to when to buy or sell a specific currency 

pair through your Forex broker.  

 

It works with most Forex brokers that use MetaTrader 4 as a trading platform.  

The Forex AI Autotrader you received initially will work with any Forex account, but you 

will need to register it within 4 to 8 weeks of purchase. Once registered, the software will be 

locked to your actual trading account. For more information, please see the Licensing section. 

 

 

Do not use the Forex AI Automatic trading system on your live account until you 

have completely familiarized yourself with how to train, configure and use the 

system. We recommend running this system on a demo accounts for at least 4 

weeks. 
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2 Installation 

 

Copy the Forex-AI-EURUSD-v3.0.ex4 and forex-ai.lic files into: 

D:\Program Files\Broker %ame\experts directory 

Copy the Forex-Ai.dll file into: 

D:\Program Files\Broker %ame\experts\libraries directory 

Forex-Ai-EURUSD-v3.0.ex4 The main MetaTrader Expert file 

Forex-Ai.dll Includes some of the trading, neural network and license 

verification routines. 

Forex-Ai.lic The license file authorizing the Forex-Ai AutoTrader to 

work on your account(s). 

 

Before you can use the Forex-Ai Autotrader please click Tools -> Options and select the 

“Expert Advisors” tab. 

Check – “Allow DLL imports 

Un-Check – “Confirm DLL function calls, as per picture below. 
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Close MetaTrader and start it again for the Forex-Ai AutoTrader to appear in the Navigator 

window Expert Advisors section. 

 

 

 

If the navigator window is not visible, select View->Navigator to make it visible. 

 

If the icon next to the AutoTrader is gray, it just means that you do not have the 

source code. It is not a fault. 

 

Open a new EURUSD chart and select H4 to show the 4 hours chart. 

 

Drag the Forex-AI-EURUSD v3.0 expert onto the EURUSD H4 chart. When you release the 

mouse button, it will display the following window. 
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Click on “Allow live trading” on the Common tab. You can also verify or change the DLL 

settings here if you haven’t done it in the Tools->Options settings. It is better to do it at the 

Options, so you don’t have to do it every time you start the EA. 

Then select the Inputs tab  

 

 

 

Set the input parameters as per “Input Parameters” section 

It is important to set the Input Parameters correctly, otherwise the Forex Ai expert 

will not work profitably. 
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Click ok. 

Check the smiley face on the upper right hand corner of the chart. 

 

If it is a sad face, you forgot to click on “Allow live trading” as per previous instructions. 

If it is an “x” you have the Expert Advisor disabled. 

 

Make sure to click on  to enable the expert and check for the smiley face. 

 

Now you are ready to go. All you have to do is leave it alone and let the Forex AI Autotrader 

do the rest. 

 

If you want to see the EURUSD pair in other timeframe than 4 hours, open another 

EURUSD chart. DO %OT change the timeframe on the chart while the Auto trading 

is on. It will not enter new positions nor will it close any open positions if you do 

that. 

 

It is quite important that the Forex AI is running on a computer that has a good 

Internet connection, ideally one dedicated to the task at hand. 

 

For our own trading, we are using a Virtual Private Server (VPS), dedicated to do 

nothing else, but to run the Autotrader. Some VPS providers unfortunately log you 

out if you disconnect and therefore your MetaTrader will be closed down as well. 

After lengthy research, we found one which appears to be reliable for our purposes 

and costs about $30/month. If you would like to know which provider we’re using 

here, at the Forex AI, please email support@forex-ai.com. 
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3 Input Parameters 

 

These input parameters need to be set each time you attach the Forex AI 

Autotrader expert to the chart. You can however save them and load the saved 

copy when you need it next time.  

 

 

3.1 ModeHelp 

It is a short help info telling you what options are available as a Mode parameter. 

Currently it has two options: A – Auto and F- Fixed lot size, described below. 

 

3.2 Mode 

A Automatic lot size mode 

Use Automatic lot size mode only if you let the Forex AI to trade on the account on its 

own. If you are also trading manually or perhaps use another expert to trade on the 

same account simultaneously (not recommended) DO NOT use Automatic mode.  

In AutoMode, the Account Free Margin, Stop Loss level and the RiskPerTradePercent 

parameter is used to determine the Lot size to trade. 

 

F Fixed size lot for each trade.  
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Use Fixed Lot size if you want to be in control of the Lot size the Expert will trade 

with. The parameter called Lots will determine the size of each trade. Default is 0.1 

Lot. 

3.3 UseMicroLots 

In Automatic Lot Size mode we need to decide whether to round the lots mini or micro lots. 

Some brokers only support mini lots, 0.1, 0.2, 0.3 etc. as the smallest order quantity. 

Some other brokers however support the micro lot sizing, 0.01 increments. Using a broker 

who supports micro lots, it allows you to trade with small amount to test things out. 

 

Using 1 micro lot and the default 90 pips S/L your risk per trade is $9. 

With a $300 account each trade is risking 3% of your balance. This is about the 

smallest account balance you should trade with, once you finished the 4 weeks 

papertrading. 

 

3.4 RiskPerTradePercent 

By default it is 3% which is a little bit higher what professional traders risk on each trade, but 

more suitable for small accounts, up to maybe $5,000. It is strongly discouraged to use higher 

than 5% risk per trade, although the EA doesn’t restrict you to do that in case you have a 

different method for risk management. 

 

The following is a known technique amongst traders to use the following alternative 

money management. 

Set aside your risk capital say $2,000, but only send 20% ($400) to the broker and 

keep the remaining amount in your regular savings account. Say your risk per trade 

is 2% on the $2,000 or $40. If your broker only has $400, you need to set 10% risk 

in the Forex-AI Autotrader to achieve the 2% risk per total risk capital. This is why 

we are not limiting the percentage of risk per trade. 

 

3.5 FixedSizeLots 

 

This parameter is only used when the trader is set to Mode F, Fixed size lot. In case you 

choose Fixed lot size, (not recommended) use the following lot sizes based on the amount of 

money you have available in your account: 
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Account Size Lot Size 

$3,000 0.1 

$10,000 0.4 

$25,000 1 

 

3.6 StopLoss 

 

By default we have set the StopLoss value to 90 pips, which we believe is the appropriate 

value for our strategy. Using a smaller value would result in a lot of premature exits of 

profitable positions.  

A larger value would probably improve our profitable trades, but would also include a few 

large losses, which could result in large draw downs in our portfolio.  

You could experiment with larger StopLoss values with an aim to generate larger profits as 

long as you understand that you may experience larger portfolio draw downs if you 

experience a large loosing strakes.  

 

3.7 SLModeHelp 

 

It is a short help info telling you what options are available as a Stop Loss method. 

Currently it has two options: P – Periodical and T- Trail as described below. 

 

3.8 SLMode 

 

P - Periodical means that we are only moving the Stop Loss (S/L) every 4 hours. We are 

moving the S/L when the new 4 hours started, based on the closing price of the previous 4H 

bar, not the high or low of the bar. 

T – Trail, it means the S/L is moved every time the price hits new high or low since we 

entered into the trade. This method may generate a lot of Order Modify calls to the broker. 

Our experience is, that some brokers don’t like this method and may eventually move your 
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account into manual execution mode, which means, each trade execution may take up to a few 

minutes to execute.  

3.9 TakeProfit 

 

If you set this parameter to 0, it will not use T/P 

If you set it to a positive number, it will use it as a profit target. There is often a minimum 

profit target set by the broker, around 5-10 pips, but we want much larger profit target than 

that. 

Because we use 4H chart and 90 pips S/L, anything less than 120 pips doesn’t make sense. 

We prefer to let the trade run to maximize our profit when there is a significant movement, 

but we recognize, that it has often happen that our profit has run up to close to 900 pips and a 

sharp downturn before our S/L was set took away 2-300 pips profit away from us.  

So by default we have set the T/P to 820 pips. It is not optimized in any way, just an 

observation based on the past 3-4 month behavior. 

 

3.10 ClosePositionsOnly 

 

This parameter is false and should be left false most of the time.  

 

If you are planning to go away for a week or two and do not want to leave your Autotrader on, 

you have two choices:  

 

- You can either remove the expert from your chart and manually close the position you are 

in; or 

- You can turn “ClosePositionsOnly” to true and the AutoTrader will find the best possible 

exit for you. It will close the position when the Forex AI system is about to reverse or may get 

stopped out. 

 

You may want to close positions for the weekends. In this case, it is best to change 

the “ClosePositionsOnly” to true on Thursday to let the expert focus on closing the 

existing position only. You may miss a Friday trade, but Fridays are typically weak 

in terms of trading opportunities anyway. 
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3.11 Primary Network Parameters 

 

alpha, beta, gamma, delta 

 

These parameters need to be set using the values we get as result of the training of the neural 

network. They control the behavior of the primary network. To see how to get these 

parameters, please look up the “Training the Forex-AI AutoTrader” section in this manual. 

 

3.12 Alt_Symbol 

 

This is the symbol name of the alternative data series to improve the probability of the 

prediction. 

 

We found that the best alternative data series when predicting the EURUSD currency pair, are 

other symbols which are correlating well with EURUSD or reverse correlating to the highest 

extent. 

Professional traders typically use Crude Oil or Gold as an indicator where the major currency 

pairs are going. Not every Forex broker gives you continuous Crude Oil or Gold prices, so if 

it is doesn’t, you need to use another currency pairs as an alt_symbol. 

 

Read the FAQ section on this document as to how to select an alternative symbol. 

 

3.13 Alternative Network Parameters 

 

alt_alpha, alt_beta, alt_gamma, alt_delta 

 

These parameters need to be set using the values we get as result of the training of the neural 

net. They control the behaviour of the secondary or alternative net. To see how to get these 

parameters, please see the “Training the Forex-Ai AutoTrader” section in this manual. 
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3.14 MagicNumber 

 

This number is added to each trade entered into by the Forex-Ai AutoTrader. This way it can 

identify which trade positions are its own and only modifies / closes the trades it entered. 

Using this technique we can run several Experts on one user account without having them 

interfere with one another.  

Obviously each Expert needs to have its unique ID, called MagicNumber. So if you are 

running other experts on your account, make sure to check their MagicNumber and if you find 

it to be the same, just change it to something different.  
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4 Training the Forex AI Autotrader 

 

Training the AI network in this expert is the most important part of the Forex AI AutoTrader 

and your success in using this application depends on whether you follow the instructions 

here properly or not. 

 

Many trading applications that use Artificial Intelligence, Neural networks give you too many 

options, are confusing and in the end you give up simply because you do not know which one 

of the several thousands of parameters to tweak. With Forex AI, we have done the hard work 

for you and this section describes clearly how to optimize the network for maximum gain. 

 

4.1 Selecting the Time Period to train the network on 

 

Before explaining the steps you need to take in order to train the network, let’s start with 

some real life examples first. 

 Select the H4 chart of the EURUSD currency pair and zoom out, so you can see 6 months on 

your chart. 

 

 

 

In the example above, I’ve charted EURUSD between March and August. As you can see, we 

have a relatively range-bound market move. If we train our network and the market behavior 

does not change significantly, the Forex-AI expert will produce good profit. 

 



Forex AI  

User Manual 

Commercial-in-confidence Page 16 of 31 www.forex-ai.com  

 

 

 

Now have a look at the June-November 2008 time frame. 

 

As you can see, this period contained a trending stage between mid July and end of October. 

November was range-bound again.  

 

Why am I showing you this? If the network has only seen range-bound markets and suddenly 

we have a large drop in price and the market starts trending downwards, the system may not 

be able to produce a profit because the market conditions have significantly changed in a way 

that the network hasn’t learned how to deal with yet. If, however, we train the network on 

both range-bound and trending markets, it has a better chance of producing profitable results. 

 

Throwing too much data at the neural network will make it irrelevant and will not work well. 

Using too little data may not be representative of the future price movements. In the neural 

network world this phenomenon is often called Curve Fitting. We don’t want that. 

 

More than 6 months’ data on a 4 hours chart can often result in irrelevant 

prediction of  the Forex AI network. 

 

 

Less than three months’ data may not be enough to learn about the rules, so use 

between 4 to 6 months’ data to teach the AI network about the past behavior. 
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4.2 Selecting Alternative Time Series Data 

 

Go through the available Market Symbols of your broker and see if you have Crude oil or 

Gold continuous price available.  

It maybe disabled by default, so to explore all symbols available, right click on the “Market 

Watch” window and select “Symbols”. 
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As you can see, a lot of symbols are grayed out, meaning they are not visible when you select 

new chart. 

Highlight the CL_CONT symbol and click on the “Show” button. 

Create a new chart based on this symbol and test it to make sure it is available for trading 

24x5.  

 

If you are thinking of using one of the futures symbols, please be aware that they 

may only trade 12 hours a day and thus not suitable for our purpose. 

 

If you do not have CL_CONT or GOLD spot price available, read on, we will explain how to 

use other currency pairs as an alt_symbol. 

 

Gold sometimes has a symbol GOLD, but more often Forex brokers are using 

XAU, XAUU, XAUUSD for Gold as well. 

 

 

As mentioned earlier, other currency pairs may be suitable as an alternative 

symbol (e.g. GBPUSD or EURGBP). Read the FAQ section of this document on 

how to select which is the best. 

 



Forex AI  

User Manual 

Commercial-in-confidence Page 19 of 31 www.forex-ai.com  

 

 

 

4.3 The Training Step-by-Step 

 

- Select View -> Strategy Tester 

- Select Forex-Ai-EURUSD v3.0 as your Expert Advisor 

- Select EURUSD as a symbol 

- Select H4 as a period 

- Model – Open prices only 

- Click on Optimization 

- Select the date range. From: 3-6 month past, To: current date 

As you can see picture below. 

 

 

 

If you are using “T” Trailing stop loss instead of “P” Periodical, you should 

change the model to “Every Tick” otherwise the training will not be accurate. 

It will take the training much longer than a few minutes. We usually train using 

the Periodic Stop Loss to speed things up. 

 



Forex AI  

User Manual 

Commercial-in-confidence Page 20 of 31 www.forex-ai.com  

 

 

 

Click on Expert Properties button. 

On the Testing tab select as below: 

Select Drawdown percent from the dropdown box. 

Make sure Genetic algorithm is ticked. 

 

 

On the Inputs tab: 
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Check the checkbox on the following Input parameters: 

alpha, beta, gamma, delta 

alt_alpha, alt_beta, alt_gamma, alt_delta 

 

Set the start value for all 8 selected symbol to 0 

Set the Step value to all 8 symbols to 1 

Set the Stop value for all 8 symbols to 200 

 

Due to some bug in MetaTrader 4 the Start value has to be set twice to stick. 

Double check it twice to make sure the values you have entered are the correct 

ones. 

 

Make sure to set the alt_symbol to the symbol you have selected in the previous point to 

continuous Crude Oil, Gold (XAU) or another Forex pair you have selected. 
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On the Optimization tab: 

 

 

Click the checkbox on “Maximal drawdown” and set its value to 30. 

This means that it only allows a maximum portfolio value drop by 30%. 

 

Then hit OK and click the Start button to start the optimization. 

 

Optimization may take 10-15 minutes, depending on how fast computer you have, but you 

only have to do this once a week or maybe once a month. 

 

During optimization, the Genetic Algorithm will go through 10,000 times on the entire data 

set and will optimize its parameter out of billions combinations. If you couldn’t find an 

acceptable result, you can re-run the optimization and will get a different result. In fact every 

user of this Forex AI is likely to get a different optimization result, therefore if I use this 

system to trade, my trading will probably be differently to yours, but both systems can be 

profitable. 
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During the optimization you can click on the ‘Optimization Graph” to see if the system had 

found any suitable combination which resulted in less than 30% portfolio drawdown. 

 

 

 

As you can see, we have plenty of results around the 17% drawdown range in our example 

and one around 13%, plus another one around a 14% mark. 

 

If you don’t see the chart like the one above, right click on the chart area and de-

select 2D surface. 

 

Click on the “Optimization Results” tab to analyze the results further. 

If you sort the results by “Drawdown %” you can see that the 13.33% drawdown resulted a 

$9,963 profit on an initial 10,000 investment or about 100% profit in 5 months. Not bad! 

 

The next line down resulted 168% profit in 5 months, but the drawdown was 14.66%, a 

slightly higher risk, but not much. 

 

Both of them are pretty good. 

Now sort the results by profit, showing the largest profit on the top of the list. 
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It appears that the highest profit in this case was one of the safest with a drawdown % of 

14.66%.  

 

You will most probably agree that 168% profit with the 14.66% Drawdown is our best choice. 

Now take note of the 8 parameters: 

alpha = 66, beta =101,  gamma = 149,  delta = 27 

alt_alpha = 194, alt_beta = 8, alt_gamma = 67, alt_delta = 191 

 

Go back to the “Seetings” tab and click on “Expert Properties” again. 

This time select the Inputs tab and enter in the Value for each of the 8 Variables. 

 

Click OK and then on the Setting tab click on the Start button. 

This time it went through the last 5 months and places trades based on the optimization 

parameters we have set. 

 

This time we didn’t have the Optimization checkbox clicked. 
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Note that the 10,000 balance has grown to almost $27,000. 

 

 

Selecting the Report tab you can see that: 

63% of the trades were profitable, but when we made profit it was almost twice as big as the 

losses (Profit Factor 1.9). 

 

 

Now you have the 8 numbers optimized to the current market conditions. 

 

Don’t be concerned about the Modelling quality %/A. The Forex AI system is 

only making transactions at the beginning of each 4-hour block, except for the 

StopLoss order, which can be filled at any time. We have run the optimization 

using “Every Tick” and produced the same result, but the optimization took 

significantly longer (Hours instead of minutes) 

 

You will often see a 4-500% profit in 4-6 month training period. The example 

above is a very conservative. 
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4.4 How often to train the network? 

 

We used to retrain the network every week until December 2008. Since than the market has 

stabilized a bit and we are only training it fortnightly. Our tests show that monthly training is 

probably enough, but given the current market turmoil of the past few months we felt training 

it more frequently gives the network a chance to learn the market behavior quicker.   

 

Best practice would be to train your network every fortnight or week if the market shows 

significant changes, otherwise once a month is sufficient. 
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5 Licensing 

 

The pricing of the Forex-AI system is worked out on the basis that you can only use it on one 

Forex broker account.  

The Forex AI version that you have downloaded initially from the website will work between 

4 to 8 weeks. This 4-8 week period gives you a chance to experiment with any broker without 

any limitation. 

Once the 4-8 week period expires, the Forex-AI expert will notify you by displaying the 

message:  

"This trial version has expired! If you have purchased the licensed copy, please email: 

support@forex-ai.com" 

 

When you are ready to activate your version of Forex AI Automatic Trading system send an 

email to support and request your permanently activated version of license file. 

 

In order for us to be able to process your request we need: 

Your Payment ID 

Your Name 

Account Number for your live trading account 

Account Number for your paper trading account 
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Your account number is displayed in the Navigation window under Accounts showed in blue 

(only in our screenshot is blue). 

 

 

   

You can activate up to two Forex trading accounts with each Forex-AI purchase: 

one for Paper Trading account and one for live trading. All you need to do is 

emailing support@forex-ai.com with your account numbers and proof of 

purchase. 

 

   

Using Forex-AI with more than 2 account numbers is possible for an additional 

$50/account fee. Simply email support and we will email you a link for the 

payment and we will send you an updated license file to support up to 6 accounts 

per license file once payment is made. If more account is needed, we just need to 

use multiple license files. 
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6 Frequently Asked Questions 

 

6.1 Q. I run the optimization, but it didn’t list any result. Why? 

 

A. The optimization has a strict criteria that only lists results as valid if the Portfolio 

Drawdown % is less than 30. There could be several reasons why nothing is reported: 

- You have selected a longer than 6 month time frame 

- The alternative Symbol is not set correctly 

- The market conditions changed so much that you need to select smaller than 6 month time 

frame for optimization. 

You can just try to re-run the optimizer again. 

 

6.2  Q. Do I select the lowest Drawdown % or the highest Profit? 

 

A. It depends on your risk tolerance. We prefer to select one of the lowest Drawdown %, but 

if only 1 or 2 extra percentage draw down produces twice as much profit, we sacrifice the 

extra safety for a potentially much larger return. The example above was quite typical. An 

extra 0.8% drawdown resulted almost twice as much profit, so we have selected that one.  

 

6.3 Q. What if none of the results look OK? 

 

A. It sometime happens that the lowest Drawdown % resulting a minor profit only. You do 

one of the followings: 

- Run the optimizer again up to 5 times and if you still find no good results, then reduce the 

period by one month. 

- Review the time frame selection. Maybe you have to lower the training time frame to as low 

as 4 month if the seriously trending market has just moving sideways in the last 3-4 month.  
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6.4 Q. My broker uses 5 digits on the EURUSD pair. Do I need to 

use 900 as a StopLoss? 

 

A. No. We have included a routine in the Forex-Ai system to check how many digits are used 

for the EURUSD currency pair and making all adjustments internally, so you still need to use 

90 for the StopLoss and not 900. 

 

6.5 Q. What are those F:-0.35573443 A:120.04323 numbers? 

 

A. They are the outputs of the two neural networks used by Forex-AI. 

The first number is the EURUSD neural network, the second number is the alt_symbol 

network output. They both have to agree before a new trade is entered. 

If both F and A are positive, the EA will go long in the next 4 hours bar 

If both F and A are negative, the EA will go short in the next 4 hours bar 

If they have a different sign, there will be no trade until they agree. 

If A is 0, that means the alt_symbol is set to an invalid one, so no data is coming in on that 

symbol 

 

6.6 Q. I run the optimizer and it just runs through fast and all 

results are discarded. 

A. Check to make sure your account is valid and allows trades. It must display the Trade 

and Account History tabs at the bottom. 

B. Drag the EA to the chart (if it is a demo account) and see what message it displays. 

Maybe your temporary license has expired. 

C. Check to make sure your account allows micro lots when UseMicroLots is selected. 

Try entering an order with 0.01 lot. If the order button id is grayed out, it doesn’t 

allow MicroLot orders. 

D. Make sure you are running the Expert on the EURUSD symbol It also allows 

EURUSDm and EURUSD-fx. All other symbols are disabled. 
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6.7 Q. When I change the Maximal drawdown in the Strategy 

Tester to 30, the number just pops back to 70? 

 

A. Press <enter> not just click to another cell when changing this value. 

 

6.8 Q. What alt-symbol should I use when my broker doesn’t 

support Gold or Crude? 

 

A. There are two ways you can approach this. The simple way and the scientific way. The 

objective is to find a well correlating or inverse correlating currency symbol to EURUSD. 

You can just pup up EURUSD and another currency pair on the screen using 6-month 4H 

chart and visually see if the correlation exist or not. 

Or you can download the data to excel spreadsheet of both symbols to determine the exact 

correlation. Here is how: 

Select the EURUSD 4H pair and click File->Save As to save its data in a csv file 

Do the same for say AUDUSD 4H pair 

Open MS Excel and File Open, select csv and open the EURUSD pair 

Open another sheet and open the AUDUSD pair as well. 

On a third page, paste 6 months’ worth of data of the closing price of each symbol. To make 

sure you have done it right, leave the date time columns there as well, so you can check if it is 

shifted due to data error or not. 

Then use “=correl(A1:A774, B1:B774)” where A is the EURUSD closing prices and B is the 

AUDUSD closing prices to get the correlation between the two symbols. 

From August the 4th 20008 till the 2nd of February 2009 I got a 92.73% correlation between 

these symbols. 

You can use other symbols to see which ones are the best and it will likely to change time to 

time, so it is advisable that you do your research every couple of month as to what symbol to 

use to get the best result. 

 

 


